Plan for today

Setting up your first project
Key decisions
Putting i-Tree Eco results to work
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Think about it...




The 2023 i-Tree Suite of Tools
Core individual tree tools
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MyTree Planting Design

Core canopy tools
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OurTrees Canopy Landscape

*i-Tree Tools that can be used internationally
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i-Tree Tool Relationships %

i-Tree

MyTree

i-Tree Engine/API:

Eco: Tree/Population

Ecosystem Services
Calculator

Design

Individual tree ‘ Planting
a benefits and
projections \

Cover multipliers:

Structure and Canopy

benefits per unit
area of tree cover

! Landscape ‘ OurTrees
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The i-Tree Eco Framework

Structure

« Summary of field
measurements

 Leaf area
 Condition
« Species distribution

« Diameter distribution

Function

Air quality improvement

Energy effects

Carbon storage &
seqgquestration

Hydrology effects

Shade ultraviolet effects
(UV)

Foodscape characteristics -
limited species info

Wildlife suitability — avian
focus

Volatile organic compound
VOC

Leaf nutrients

i-Tree

Value

Monetary value
Equivalent values
Health outcomes
Cost Benefit analysis

Summaries for
management



Eco flexible tree data variables

Minimum Required Tree Data
1. Tree species
2. Diameter at breast height (DBH)

Optional but Recommended Tree Data

Total tree height

Height to live top

Height to crown base
Crown width (N-S)

Crown width (E-W)

% Crown missing

% dieback (condition)

10. Crown light exposure (CLE)
11. Land use

© 0N O U AW

CROWRN LIGHT EXFOSURE

niergy Effect loptional
Colle H trees = 20ft (B.2m) tall and within 807t [18.3m) of a 3 story or Barcham
fewer space conditioned rr::lﬂn:nleu iding.

Direction from tree ta building -
1%-360"

CLE affects tree growth rates and accounts
for competition with other trees for access
to light.

Crown base

25% Canopy missing

10% Canopy missing 0% Canopy missing

40% Canopy missing

30% Canopy missing

15% Canopy missing



. Table 2.—Summary of which directly field-measured characteristics are used to estimate derived
F ro I I l fl e I d d a t a t O r e S u I t S variables and ecosystem services. D= directly used; I= indirectly used; C= conditionally used.
DERIVED
VARIABLES ECOSYSTEM SERVICES
=
o c
QS/_DA Forest Service E ‘E
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Total height D D C C C D D
Wil | Crown base height D D Cc
Il | Crown width p|p|c
?) Crown light exposure C| D | D
o 8 Percent crown missing D D C C C D
1- re e = Crown health (condition/ D D D D
™ dieback)
Field land use D D| D
Distance to building D
Direction to building D
Page 22 O Percent tree cover D D D
https://www.fs.usda.gov/research/treesearch/63636 =
I Percent shrub cover D
-IC-)) Percent building cover D
o Ground cover composition D



https://www.fs.usda.gov/research/treesearch/63636

i-Tree model basics: Inventory datammp tree benefits? ﬁ

i-Tree

[City Data] [ Pollution Data ] [ Weather Data ]

LSpecies Data ] Location Data ]
(8000+) l

Vv




Let’s set-up an i-Tree Eco project %

i-Tree

{ Rochester, MN
Street Tree Inventory




Key Decision: sample or complete inventory

Random sample of plots

* City

* County

* Regional or watershed

* Large scale or forested areas

Complete inventory

* Parks

* Campuses

* Residential properties ._
 Specimen or single trees HYDE PARK

TREE BENEFITS Jda
* Only trees of interest PN P

: i 1l
L . 2,240 %




What is a sample and why would you do it?

A small subset of the
items you are
interested in

Easier than
measuring the whole
thing

For statistical reasons
must be random

We can estimate how
well our sample
represents the whole
population

This is how London
measures 8.5 million
trees

i-Tree

SURVEY PLOT
QOUTER LONDON

INNER LONDOMN



What is a plot?

« By default 37.2 ft
in radius, 1/10t
acre in area.

Plot size can be
changed

« Tradeoffs between
plot size and the
number you can
measure




Sam

ole Plots vs. Complete Inventory

trees

Characteristic Sample Complete
Recommended area City or larger Any
Number of plots 200 or more None
Typical number of ~500 Any

Numerous permissions

area of interest

Access : Often no permission required
usually required
Some loss of accuracy due to| No sampling error, all trees
Accuracy : :
sampling error of interest measured
Estimates expanded to whole | Estimates only for measured
Results

trees




Key Decision: Will you stratify? ﬁ

i-Tree

Dividing area of interest into categories

 Can be performed by any categories
of interest (land use, ownership,
political, watershed, etc.)

« Summaries generated by categories
of interest

* Perform pre- or post- measurement ]
(Sample must be random) Land Use Stratification 4

Strata
[ ] Commercial

[ ] Industrial
* Can improve statistical accuracy [ Residential

Underdeveloped




Stratification: Sample and complete inventory

Project Edit View Layer GSettings Plugins Vector Raster Database Web Progessing Help

[

Lzyers Panel
& =7

2016EAB
SW-Downtown

NW-Downtown
NE-Downtown
CombinedDow... |
Rochester_bo...
% Bing Aerial

. cb_2014 us_c.

%
x|
x
x

Lake Michigan

.' —1Miles
* i-Tree plots B City of Chicago County Boundaries

oordinat -10295980, 5470150 ¥ 134410 | v @ lagnifie| 100% 2| otatior 0.0 2 % Render € EPSG:3857 (OTF)

https://mortonarb.org/app/uploads/2021/05/2020-Chicago-
Region-Tree-Census-Report__ FIN.pdf



Key Decision — Data entry
manual, mobile, or import

i-Tree Eco vE sample plot data sheet

[ check when plot is completed

Sheet of Initials :

Plot Information

Plot ID: | Strata: GPS Coordinates | Date: Crew: Plot Size:
Lat.
Long

Plot Address:

Plot Contact Name: Contact Type or Title:

Phone #: Email:

Plot or Access Notes:

Plot Tree Cover (%) | Shrub Cover (%) | Plantable Space (%) | Percent of Plot Measured (%):

Did this Plot have any Trees? (Y/N);

Photo ID(s):

Manual data entry:

Permanent stake used? (Y/N,

Project Configuration Da

1= I

Paper | Submit
Form | to Mobile from Mobile

Data Collection

Retrieve

Help
Data > Inventory Data > Plots

The Plots function seen in the action panel
to the right is where you can enter or edit
the plot data that you collected in the
field (see Notes below). The upper table
displays your plot data. While working in
this table, you may use the tools in the
Actions group to help manually enter new
data or edit data that has already been
added.

Steps to Viewing Plot Data:

1. When you click on a record in the
plot table, additional plot data will
be displayed in the table below it.

2. Usethe tabs located at the bottom of
the action panel to view different plot
data in the lower table.

3. Hide the lower table by clicking on
the pin button in the upper right-hand
corner of the table.

4. Unhide the lower table by clicking on
one of the tabs at the bottom of the
action panel and clicking on the pin
button again.

Steps to Manually Add/Edit Data:

1. Click in the box where you would like
to enter data and begin typing.

2. Usethe Tab key on your keyboard or
the left and right arrows to move from

ogQ
ol
0@

Plots Trees Shrubs Check

I

-

m

[Project: Adrian] [Series: Adrian_2012] [Vear: 2012] - i-Tree Eco v6.0 4

View

Reports

Forecast

Support

s M O&E & §

Inventory Data

CsV KM

L | Benefit Annual

Editing

Data Prices Costs | Mode: Off
Export Inventory Value
Data > Inventory Data > Plots
ID  kude (Y) | Longitude (X) | Date Crew Contact Info | Size (: | Photo ID Stake % Tree | % Shrub | % F_
1 8656011 | -B4.0385827151 | 4/24/2.. |Team 2  |fdafdsa for 0.10 [} 10%-15% [1%-5% 30%--
2 138815014 |-B3.9977850608 | 4/18/2... | Team 1 0.10 [} 1%-5% 65%-70% | 10%-
3 15508675 |-84.0575169972 | 4/25/2.. | Team 2 0.10 [} 1%-5% 10%-15%  [30%-
4 4037655 |-B4.0336271443 | 4/23/2... |Team 1 0.10 [} 1%-5% 1% - 5% 0%
5 78022666 | -84.04334209271 | 4/24/2.. | Team 1 LAl (=] % 5% -10% %
3 797455 | -B4.0694443255 | 4/19/2... |Team 1 0.10 [} 0% 0% 30% -
7 10326133 |-84.0622501734 | 4/19/2... | Team 2 010 (=] 45%-80% | 1%-5% B -1
8 (08126706 |-84.0363356381 | 4/24/2... | Team 1 0.10 [} 18%-20% [0% 15% -
3 196562689 | -B84.069754852 4/19/2... | Team 2 0.10 [} 0% 0% 100%
10 1926253 |-84.0396421345 | 4/24/2... | Team 1 0.10 [} 0% 0% 0%
€ ’ T i — R A
Trees
v Survey Date Status Distance (ft) Direction Species Land Use [
2 47272012 Ingrowth 15.20 338 | Black chemy (Prunus serotina) Vacant
3 4/27/2012 Ingrowth 3460 352 | American elm (Uimus americana) Vacant
4 4/27/2012 Ingrowth 10.00 0 | American elm {Ulmus americana) Wacant
5 4/27/2012 Ingrowth 17.70 10 | Black chemy (Prunus serctina) Vacant
[ 4/27/2012 Ingrowth 3520 20 | Silver maple (Acer saccharinum) Vacant

Collect on paper then directly enter in the

I-Tree Eco interface




Data entry: mobile or manual

i-Tree

 Web-enabled mobile
evice or paper

 Measure required &
optional variables

View  Reports

Invertory Data | Bxport

k_;‘ Data > Inventery Data > Plots

D strata Address Date Crew Contact Info *

e Run data in model to

Laroe Residenti | beach front o 8/25/2010 | Team 1_Mike ” ak
Lorae Residerti_|lake washington 8/25/2010 | Team 1_Mke Crown Base Height (ft)
Loras Residenti |12k washington 8/25/2010 | Team 1_Mike
Large Residenti | 18418 515t plne £/30/2010 | Team 1_Mice Grown Tap Height (1)
. TeamiMke ' )
Laroe Residenti | king county water distict vacant lot located ot 19520 47h ave. ne. | 9/11/2010 i
Loroe Residenti | 3321 n 20270 972272010 Crown NS Width (ft)
Loras Residenti | west side of acacia cem 8237200
Laroe Residerti | Acacia Cemetery 91872010 Crown EW Width (ft)
Large Residenti | heavily covered invasive himalayan black bery S/10/2010 s
Large Residenti | northshore uiity district 47t ave ne SM18/2010
2 Small Residerti 15327 beach diive ne. 10/14/2010 Crown Light Exposure 4 v]
3 Small Resderti | 1901710 pi 107172010
1 Loras Residerti | 510502 130th st 8/17/2010 | Team 1_Mike Crown Percent Missing | 13 )
15 Large Residerti 3047 ne 180th st 10/6/2010
1 Large Residerti | 18404 47th plne 3/24/2010 | Team 1_Mie
7 Larcs Residerti | 19620 47h avene 10/4/2000 Crown Dieback 13 (v]
B Larce Residenti | 18211 Balinger Way NE. 9/26/2010
19 Loras Residerti | 19535 38 ave ne 33172010 v Percent Impervious ” )
< >
liees &, Percent Shrub 8 o
Status Distance (ft) Direction Species Land Use DBH 1 (in)
Plarted 2100 96 | Westemredoedar (Thuja plicata) | Vacant 12
Plarted 1700 104 | Westem redcedar (Thuja picata) | Vacant 56
Plarted 2600 112 | Westem redcedar (Thuja piicats) | Vacant 73
R T W T —)
Plarted 1100 0| Westem redcedar (Thuja piicata) | Vacant 62
Plarted 1100 183 | Westem redcedar (Thuja piicats) | Vacant 180
Plarted 300 193 | Westem redeedar (Thujs picats) | Vacant 27
Plarted 2000 208 | Westem redcedar (Thuja plicata) | Vacart 45
Plarted 2600 210 | Westem redoedar (Thuja plicata) | Vacart 17
Plarted 1700 232 | English holy llex aquicium) Vacant 14
11 Plarted 200 231 | Douglas fir (Pseudotsuga menziesi) | Vacart 23
2 Plarted 300 235 | Westem hemlock (Tsuga heterophyla) | Vacart 85
1 Plarted 1800 241 | Englih holy (llex aqufoium) Vacant 33| v
< >

g Reference Objects |WS Ground Covers [Wd Land Uses |Wd Trees




Data import

i-Tree
,C.

AutoSave | Henning, Jason  HJ Lt

File Hom Insert Draw Page Formi Data Revie View Autor Devel Help Acrok Powe 15~

El % &l Conditional Formatting ~ . . .

_ . Format as Table ~ - y — m—
Clipboard Font Alignment | Mumber @ Cells Editing | Analyze » P [Project: Adrian] [Series: Adrian_2012] [Year: 2012] - i-Tree Eco vb.0.4

- - - - [ Cell Styles ~ - - Data ) .
- Project Configuration Data View Reports Forecast Support
Styles Analysis 5ens Y | EaE
F 8 B EH@sV@D S
B3 M f Maackia - Paper | Submit  Retrieve Plots Trees Shrubs Check | CSV KML | Benefit Annual Editing
Form | to Mobile from Mobile Data Prices Costs | Mode: Off
Data Collection Inventory Data Export Inventory Value
A | B | c | D | E | F | (E Hel i |
N . . elp

1 |Zone Species Scientific Name DBEH CONDITION » | Data > Inventory Data > Plots
2 |NE Hackberry Celtis occidentalis 22 Poor Data > Inventory Data > Plots M
3 |[NE  MapleNorway Acer_pI’T!tInF)ldes 15 Good I The Plots function seen in the action panel ID tude (Y) | Longitude (X) | Date Crew Contact Info | Size (: | Photo ID | Stake % Tree | % Shrub | % F_
4 |[NW Honeylocust Gleditsia triacanthos 24 Good to the right is where you can enter or edit 1 2656011 |-B4.0385827151 | 4/24/2. |Team2 fdafdsa far 010 1 |10%-15% [1%-5% 0% -
5 |NW Crabapplespp Malus 4 Good the plot data that you collected in the 2 (38815014 |-83.9977850608 | 4/18/2... | Team 1 010 B [1%-5%  [esu-70%  |10%-
6_ SE redbud. East . d - 3P field (see Notes below). The upper table § .

| edbud, Eastern cercis canadensis oor displays your plot data. While working in | = 3 (15508679 |-84.0575163972 | 4/25/2... | Team 2 010 [ [1%-5%  |[10%-15%  [30%-
?_ SE Pinespp. Pinus 15 Poor this table, you may use the tools in the 2 4037655 |-84.0336271443 | 4/23/2. | Team 1 010 [ 1% 5% 1% 5% o
8 |SE  LindenOrnamental Tilia cordata 18 Good Actions group to help manually enter new "

- I = data or edit data that has already been 5 (70022666 |-84.0433420921 | 4/24/2. | Team 1 010 | 0% 5% -10% (174
9:|SE | Maackiz Amur maackii 4/Dead added. 6 797495 |-B4.0694443259 | 4/19/2.|Team 1 010 B |ox 0% 0% -
10 |SE  MapleMorway Acer platinoides 6 Poor ; r——— 732 | 471972 | Team2 010 B 4o%-50% %% o

= T i . 0326 062250 eam . - - -
11 |SE  Redbud, Eastern cercis canadensis 3 Poor Steps to Viewing Plot Data: |
— e B 1. Whenyou click on a record in the 2 18126706 |-B4 0363356381 | 4/24/2 | Team 1 010 B |15%-200 |0 15% -
12 |SE Honeylocust Gleditsia triacanthos 17 Fair plot table, additional plot data will
13 INW  Hawthorn spp. crataegus 2 Good be displayed in the table below it. 5 (56562689 | -84.069754892 4/19/2... | Team 2 0.10 [} 0% 0% 100%
al - 2. Usethe tabs located at the bottom of 10 [1926253 | -84.0396421345 | 4/24/2. | Team 1 0.10 B o|o% 0% 0%
14_SE Crabapplespp Malus 6 Dying the action panel to view different plot . o | o4 010 e . - .
15 |SE Redbud, Eastern cercis canadensis 3 Fair data in the lower table. P T B b
16 [NW  AshGreen Fraxinus Pennsylvanica 19 Good | 3. Hide the lower table by clicking on
= . . the pin button in the upper right-hand Trees
17 |NE  AshGreen Fraxinus Pennsylvanica 18 Good corner of the table. _ _ _
18 [NW  MapleSugar Acer sachrum 28 Dying I 4. Unhide the lower table by clicking on D Survey Date Status Distance (ft) Direction Species Land Use
q | P one of the tabs at the bottom of the .
20 |[NW  MapleSilver Acer sacharinum 35 Excellent button again. 2 4/77/2012 Ingrowth 1920 338 | Black chemy (Prunus serotina) Vacant
N [ v . [ i
E;_ii ;Ist;Twencana princeton i'mus E:‘ET'CE“E princeton 3; 2003 Steps to Manually Add/Edit Data: 3 4/27/2012 Ingrowth 3460 352 | American elm {Ulmus americana) Vacant
2 | El; e II\I’ET Celr sacharinum o0 1. Click in the box where you would like 4 A/27/2012 Ingrowth 10.00 0 | American elm {Uimus americana) Vacant
23 |[NW  Crabapplespp Malus 7 Dying [l to enter data and begin typing. -
— 5 472772012 Ingrowth 17.70 10 | Black chemy (Prunus serotina) Vacant
24 |NE  MapleNorway Acer platinoides 19 Good 2. Use the Tab key on your keyboard or
— | the left and right arrows to move from [ 472772012 Ingrowth 3520 20 | Sitver maple (Acer saccharinum) Vacant
25 |SW  Crabapplespp Malus & Good
26 |SE LindenCQrnamental Tilia cordata 15 Good
27 INE  Ginkgo Ginkgo biloba 2 Fair
28 |SE  Honeylocust Gleditsia triacanthos 5 Poor
29 |5E  MapleNorway Acer platinoides 17 Fair
30 [NE  Hackberry Celtis occidentalis 2 Fair
En P ]

Rea

dy

Rochester Street Trees |

® K|

| [

ff/)\ccessibilit;: Good to go

[ Display Settings

H B O -—%—

1008




Data entry: mobile, manual, or import

Mobile

e Useful for citizen
science

 Multiple people
can do data entry

* Need device,
safety, battery

* Tedious for plots
with lots of trees

Manual

e User paper for
permanent record

* Fewer potential
Issues

* Single user
* Slow

Import

Ultimate flexibility

Add value to
existing inventories
Quick

Now works for
samples or
complete inventory

‘Pﬁ:ﬁﬁ’i
i-Tree




Let’s get some data into i-Tree Eco %

i-Tree



Let’s get some data into i-Tree Eco ?

i-Tree

Mobile data entry



https://bit.ly/3KMHVSr

I-Tree Eco structure results

Species Diversity/Composition
Diversity reduces environmental

threats, increases resilience

Il Norway maple
65 £ [ Apple spp
1 I Honeylocust
60 I Spruce spp
= I Sugar maple
501 B Ginkgo
45 { Il Green ash
40 | I Northern hackberry
.35 I American yellowwood
£ 30 I American elm
25
20
15
10
5

DBH Class (in)

Honeylocust (6.4%)

Spruce spp (5.9%) Apple spp (7.7%)

Sugar maple (5.8%)

MNorway maple (15.3%)
Ginkgo (5.2%)

Green ash (5.2%)

Northern hackberry (5.2%)

American yellowwood (4.4%)

American elm (3.6%)

Other (35.3%)

Size/Age Class Distribution
Distribution of age informs sustainability



I-Tree Eco management focused results

Appendix VI. Potential Risk of Pests

Fifty-three insects and diseases were analyzed to quantify their potential impact on the urban forest.

Code Scientific Name Common Name Trees at Risk Value

(#) (S thousands)
AL Phyllocnistis populiella Aspen Leafminer 30 8.94
ALB Anoplophora glabripennis Asian Longhorned Beetle 5,080 6,037.13
ARCA Neodothiora populina Aspen Running Canker 0 0.00
ARD Armillaria spp. Armillaria Root Disease 4 2.86
BBD Neonectria faginata Beech Bark Disease 0 0.00
BC Sirococcus clavigignenti Butternut Canker 145 273.64

juglandacearum

BLD Litylenchus crenatae mccannii Beech Leaf Disease 0 0.00
BM Euproctis chrysorrhoea Browntail Moth 891 335.73
BOB Tubakia iowensis Bur Oak Blight 105 291.08
BSRD Leptographium wageneri Black Stain Root Disease 4 2.86
BWA Adelges piceae Balsam Woolly Adelgid 1 0.25
CB Cryphonectria parasitica Chestnut Blight 0 0.00
DA Discula destructiva Dogwood Anthracnose 0 0.00

i-Tree



i-Tree Eco tree function

Storage (ton)

1400 -

1200 -

1000 -

800 A

600 -

400 -

200 -

Carbon Storage

- 220
L 200
- 180
- 160
- 140
L 120
L 100
- 80
- 60
- 40
- 20

-0

Value {thousands $)

i-Tree



I-Tree Eco tree function ﬂ

i-Tree
Rochester Inventory Data
260 - 2500 S//ver maples - _
_ - o | ree count:

5 %20 - 2000 Leaf area:
5200' 33 acres
c -
a 180 - 1500
2 160 - 2
- w
'«'lé 140 - '_i
c [ 1000 ~
2 120 4
=
5 100 Tree count:
:% 80 - L 500 623

60 - l l l Leaf area:

40 - Lo 40 acres

O
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\;o*“‘\ &&? A * \,&ée’ & _\&6"
& A &



i-Tree Eco detailed results

Hourly Ozone Concentration

L. 01
£ c
£ 8
$ £ =005, IN|M
< € | il |I|HJ\ M { 1] i i
= 3 1 \\ V m] “ | I |i |Il|l|l “ r{” WJ ‘l’" ” |J‘| Jnrh 1|| H ﬂﬁl
5 ORI T ™
1/1/2020 3/3/2020 5/4/2020 ?;5;2020 9/5/2020 11;5;2020
Date
1.5 -
£ 1] Hourly Precipitation
£
5 051
0 T | bl ll..l. [ ol ‘ ‘| | 4111 il IJi |
1/1/2020 3/3/2020 5/4{2020 7,'5/2020 9/5/2020 11/6/2020
Date
0.04 - Hourly Ozone Reduction by Trees
3§ go00 ‘ |
R
- i li 11
- 0ttt nsabrortionit il il s "l l'thMLﬁ'P' W& 'l 'J e |l Jh'h Wl' I'Hml sty bl i oo ol
1/1/2020 3/3/2020 5f4;zozo 7/5/2020 9/5/2020 11;5;2020

Date




i-Tree Eco health ﬁ

i-Tree

Air Quality Health Impacts and Values by Trees

Location: Rochester, Olmsted, Minnesota, United States of America

Project: Rochester Street Trees, Series: 1, Year: 2023 I_TI‘CC
Generated: 4/18/2023 :

NO2 03 PM2.5 SO2 All
Health Outcome ($/yr) ($/yr) ($/yr) ($/yr) ($/yr)
Acute Bronchitis 0.05 0.05
Acute Myocardial 13.31 13.31
Acute Respiratory 0.99 77.97 28.87 0.17 108
Asthma Exacerbation 39.16 19.05 3.69 61.9
Chronic Bronchitis 72.41 72.41
Emergency Room Visits 0.10 0.13 0.10 0.05 0.38
Hospital Admissions 21.86 31.31 4.49 57.66
Hospital Admissions, 3.16 3.16
Hospital Admissions, 2.24 2.24
Lower Respiratory 0.34 0.34
Mortality 3153.14 5791.25 8944.39
School Loss Days 38.07 38.07
Upper Respiratory 0.25 0.25
Work Loss Days 8.95 8.95

Total 62.10 3300.62 5939.98 8.41 9311.11



i-Tree Eco Forecast ﬂ

Leaf Area of Trees Over Time i-Tree
550 -
500 -

450 -

350 -
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Leaf Area (ac)
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I-Tree Eco:
Thinking big

M

ONtreeSNve

A PLANYC INMITIATIVE WITH NYC PARKS AND MEW YORK RESTORATION PROJECT

About MTNYC
Plant

Care

Educate
Donate

Contact MTNYC

Calendar

Quick Links
ATTEND A WORKSHOP

ADOPT A TREE

ATTEND A TREE PLANTING
REQUEST A STREET TREE
PICKUP A FREE TREE
REGISTER YOUR TREE
APPLY FOR A MINI-GRANT

Find Us on Facebook

Wl Follow 71K

Loading Images
Please Wait

< SHARE

GET INVOLVED

Newsroom
Press Releases

NYC MAYOR MICHAEL BLOOMBERG AND BETTE MIDLER
PLANT TREE ONE - THE FIRST OF ONE MILLION TREES - AND
LAUNCH MILLIONTREESNYC

Today New York City Mayor Michael R. Bloomberg and New York Restoration
Project (NYRP) Founder Bette Midler launched the MillionTreesNYC initiative
to plant and care for one million trees throughout the City's five boroughs in
the next decade. The Mayor and Ms. Midler planted a street tree in the
Morrisania section of the Bronx — a neighborhood with too few trees and high
rates of asthma - and declared the Carolina Silverbell to be the first of one
million trees.

Through a mix of public and private plantings, MillionTreesNYC, an important
initiative of PlalN'YC, will expand New York City's urban forest by 20%. All New
Yorkers will share in the many benefits that come from planting trees — more
beautiful neighborhoods and parks; cleaner air and water; higher property
values; energy savings; cooler summer streets, yards, and public open
spaces; and a healthier, more environmentally sustainable City.
MillionTreeshNYC will get New Yorkers involved in the planting and caring of
trees for the next decade.

Mayor Bloomberg and Bette Midler were joined at the announcement by First
Deputy Mayor Patricia E. Harris, Deputy Mayor for Economic Development
and Rebuilding Daniel L. Doctoroff, Parks Commissioner Adrian Benepe, City
Planning Director Amanda M. Burden, Director of the Mayor's Office for
Long-term Planning and Sustainability Rohit T. Aggarwala, United States
Forest Service Abigail Kimbel and The Home Depot Foundation President
Kelly Caffarelli.

“New York City has always been a place of big dreams and big ideas — and
our Administration has never been afraid to embrace them,” said Mayor
Bloomberg. “Over the next decade, with our friends at the New York
Restoration Project, we are going to plant an unprecedented one million new
trees across the City. Plai'YC is our plan to make New York a greener,

© O © Transiate this Page | Sign up for Newsletter | Calendar




i-Tree Eco: Power of stratification

City owned parkland is 9% of the city

Trees on city owned parkland account
for 40% of carbon storage and

sequestration

Feature Estimate
Number of trees 1,100,000
Tree Cover 64%

Carbon Storage

Pollution Removal

273,000 tons ($19.4
million)

179 tons/yr ($6.6
million/yr)

Parkland

Figure 1.—Fhiladelphia ity boundaries and designated parkland areas, 2012

i-Tree



i-Tree Eco Example: Large project with targeted results ﬁ

i-Tree
Ash Trees:
City stands to lose
7.1%0 of its forest
and millions in
benefits to
emerald ash borer

% of Total Species Group

Parameter Estimate  Units City Rank
Population 206,996 number 7.1 3
Density 2.3 trees/acre 3
Carbon stored 35,742 tons 5.1 7
Carbon sequestered 1,025 tons/year 3.8 11
Net carbon sequestered 935 tons/year 4.0 10
Leaf area 4,818 acres 5.2 7
Leaf biomass 1,936 tons 6.3 3
Trees, diameter 1-3 in. 111,777 number 54.0° 2
Trees, diameter >18 in. 10,557 number 5.1° 12

 Percent of all ash trees



I-Tree Eco: Small project with big value

@ Abington Township Montgomery County, PA

e

Introduction Master Tree Action Plan Abington’s Urban Tree Canopy A Closer Look Tree Canopy Cover by Populatio... Selected Land Uses Summ

“1Tee dIZe VIatters. 1€ Neignoornooas 1[arge,
mature shade trees have the most leaf area and
provide the greatest benefits. While trees 30” or
greater in diameter make up only 8% of the

population - their canopies make up 27% of
the neighborhood’s leaf area. A comparison of
the benefits of an 11” diameter Dogwood tree
and a 30” diameter Maple tree growing in the
neighborhood shows that the Maple provides

‘nearly 8 times the ecosystem benefits as the
Dogwood.

To maximize the benefits Abington’s tree canopy
provides - we should focus our private property
efforts on preserving our existing large trees and
planting species that will grow to be large shade

trees to replace those we have lost or will lose in
'the future.

08

09

https://storymaps.arcgis.com/stories/ed7e547aeaed454ea5dd44c4b1be08cO



https://storymaps.arcgis.com/stories/ed7e547aeaed454ea5dd44c4b1be08c0

I-Tree Eco: Advantages

* Local Modeling — Eco uses available local
hourly weather & pollution data and other
local characteristics for modeling

-

* Dynamic model — constantly improved ‘TJ.?

Definition
with new science, international locations,
new reports and functions

[Project: Oconomowoc Parks] [Series: Park trees] [Year: 2017] - i-

Project Configuration Data View Reports

B & & &

land DBH Condition
Use Class

Y| Project Configuration > Project Definition

process.

Project Settings Location Data Collection Options

* Flexible data collection and project design
options make Eco accessible to more
people (from front yard to whole city)

* The Eco import option is a great way to

assess existing tree inventory data quickly
(format data before importing to save time)

Not all cities for international locations are available due to limitation

Select a nearby representative location in these cases.

Nation: United States of America
State: Wisconsin

County: Waukesha

Place Dconomowog

Is the study area Urban? [

Population: [157s8

Please specify the following years for your project:

Weather & Pollution Year: | 2015 (Weather and Pollution)

Please select a weather station to use for your project:

Weather Station: 726400-14839

Weather Slslion Selecior = O
g

Map Satellite Use the map below to select a lﬂfﬁ“ﬂ‘l“‘m“““
£ weather station to be used 5 5:;:5
with your project. Simply click * 10 miles
a station marker to select it; * 25 miles
click a different marker if you ~ Weather Station lcons
change your mind. Selecied

L L]
- ~ i andom Lak Good Completensss

-

— | Mayville ' Fair Completeness

. ]

Proom Wedton G5 GENERAL MITCHELL INTE ¥ Poor completeness
Juneat
— ID: 726400-14839 Zoom to Selectad Sta
Tree Ecod = Year: 2015
HE  Elevation: 204.20 (meters 7aom to Project Loca
Sup Position {lat, lon): 42 95, -87.90
3 | Annual Hourly Precipitation: 858.01 (millimeters
- Annual &-Hour Precipitation: B51 97 {millimeters
¥ .1.-:--,.'z--| Collection Completenass: Fair

F " o Milwgkee
Waukesha < v

ktking

Enter project overview information and click OK to save it or Car ak Creek

fhitewater

Google =

E
w  Please check adjacent

Counties/Regions/Divisions/etc. for specific
lecations that may straddle these areas. Eg.
Columbus, Ohio, USA is listed under Delawars
county, although expected in Franklin county

Show Map




I-Tree Eco: Advantages

e Options to improve the model.

e.g. users can submit new species,

hourly rainfall data, biomass
equations (i-Tree Database)

* Flexible results — Eco reports by
species, strata and individual tree
to help with strategic decision
making.

ﬂ@; i-Tree Database ...,

Homa Project = Vigw Database = Add to Database = Manu - Fandback =

&%

Species

Homs © Add io Database
Species

Walcome Al Zelaya, this applicalion alows you (o add new tree spacias and thelr associated
infermatian fo the - Tree databases for use in the )-Tree [aols and aoplications. Please IV in all
requirad information and then submit his Infarmation to the -Tree Team.

“Ganus Nams: Fagus v Add Naw Genus L
2]
Q
"Species Mamea:
Fasouined
1+
ﬂ [Project: Hartland] [Series: Comg Famiy: Fagacene ' v
m Project Configuration Data View Reports Forecast Support [+
\ Lo 2 | = e :
I% ﬁ) ﬁ ID l! :,J & English | Common | 7! Coordinates s’
\ Project Submit Data & Written Composition  Benefits  Individual Pest  Polution and - Scientific Comments | Model | Map Actve CSV
Metadata for Processing Retrieve Results | Report and Structure ~ and Costs~ Level Results~ Analysis~  Weather~ Notes | Report (beta) (beta) |
Formatted Reports Charts Settings

“l:b Reports > Formatted Reports > Individual Level Results > Tree Benefits and Costs > Hydrology Effects
- u_xs R-0 5% +® 200 @-9- OEDMB:[C)An

vvvvvvv [ I 4 [ T U S R T S I SO RN - JO TN T RO [N Y TN U A SR TN SN NN SO U S U T S TN TS S B
- Hydrology Effects by Ind|V|duaI Trees
. Location: Hartland, Waukesha, Wisconsin, United States of America
- Project: Hartland, Series: Complete Inventory, Year: 2012
~ Generated: 3/1/2020

0 @ Page1

o Tree ID Species Name Leaf Area Potential Evapotranspiration | Evaporation Transpiration Water Intercepted | Avoided Runoff Avoid
~ (m?) (m#/yr) (m>/yr) (m?/yr) (m?/yr) (m/yr)
i 1 Ulmus americana 1,962.0 147.4 16.6 54.8 16.7 33
2 Ulmus americana 1,688.1 126.8 14.3 47.2 143 2.8
N 3 Ulmus americana 2,034.2 152.8 17.2 56.8 17.3 34
4 Ginkgo biloba 255.6 19.2 2.2 71 22 0.4
i 5 Ginkgo biloba 356.3 26.8 3.0 10.0 30 0.6
- 6 Ulmus americana 695.8 52.6 5.9 19.6 59 152
2 74 Fraxinus americana 'Autumn Purple’ 214.5 16.1 18 6.0 18 0.4
8 Quercus bicolor 216.8 16.3 18 6.1 18 0.4




Use i-Tree Eco ...

... when you have existing
data

... when you have resources
for a large-scale project

... If you can make good use
of the wealth of results

... 10 support management

... when interested in a plot-
based sample

... for centralized project
management

Try another i-Tree tool ...

... when working with
students or the public

... to show that trees have
benefits

... when time is limited

... to start conversations on
trees and tree benefits

... when you are interested in
canopy cover

... for priority planning




Test your decisions with a pilot project! Street lrees & Our &

Business Districts i‘Tree

A pilot project is a small project
designed using the set-up you are
considering for a larger project.

* Test assumptions and methods
* Evaluate challenges and limitations

* Can be expanded to become your
target project




Additional resources — project planning ﬂ

Project Management
Idaho Treasure Valley i-Tree Eco Project Management Report - This document developed by David Stephenson, Idaho Department of Lands Community
Forestry Program, provides suggestions, methods, tips and tools to help future Eco project managers.

i-Tree

Eco Project Cost Estimation - This document, developed by Eric Kuehler from Urban Forestry South, offers a cost estimate for an Eco project. Note -
Numerous factors can affect project cost and this is provided only as a general guideline.

Eco Project Time Estimation - This document, developed by Eric Kuehler from Urban Forestry South, provides time estimations for planning and conducting
an Eco project.

Eco Project Timeline - This document, developed by Eric Kuehler from Urban Forestry South, is an example of a Eco project time line for a county
assessment.

Eco Project Equipment List - This is an example of equipment options for a typical i-Tree Eco project.

Eco Report Explanation Brief - This document, developed by Eric Kuehler, USFS Urban Forestry South, and Francisco Escobedo, University of Florida, provides
a brief explanation of and uses for the i-Tree Eco reports.

City of Milwaukee - Notification Letter - This is an example on an access notification letter sent to residents provided courtesy of the City of Milwaukee.

City of Milwaukee - Access Response Card - This is an example on an Eco plot access response card sent to residents provided courtesy of the City of
Milwaukee.

Data Collection Guides

Eco Field Data Cheat Sheet (1 page field resource) updated 03.28.2021 - (16 MB pdf) This two-page guide is great to have in the field for inexperienced crews
or when you need a reminder of how to collect Eco data and measurements for a given tree. This document was developed by Naomi Zurcher of Arbor Aegis
in support of the Swiss i-Tree Eco project.

Casey Trees UFORE Management Guide - This guide, which was developed by Casey Trees in Washington D.C., provides detailed guidelines for planning,
managing and executing an i-Tree Eco project.

Cascade Land Conservany (CLC) Integrated Forest Assessment Report - This document was developed by CLC in Seattle, WA, and describes outreach efforts
and guidelines for planning and managing Eco plot access issues.

Eco plot descriptions Powerpoint (PDF) - This is a PDF file of a PowerPoint used for Eco plot training developed courtesy of Keith Sacre from Treeconomics

Eco Data Explanation Sheet - Brief description of Eco sample project plot & tree data collection options.



https://www.itreetools.org/support/resources-overview/project-planning-and-management-2
http://www.itreetools.org/eco/resources/Idaho_Eco_Project_Management_Guide.pdf
http://www.itreetools.org/eco/resources/Eco_project_cost_estimate.pdf
http://www.itreetools.org/eco/resources/Eco_project_time_estimates.pdf
http://www.itreetools.org/eco/resources/Eco_project_timeline.pdf
http://www.itreetools.org/eco/resources/Eco_project_equipment_list.pdf
http://www.itreetools.org/eco/resources/Eco_reports_explanation.pdf
http://www.itreetools.org/eco/resources/Milwaukee_Property_Access_Notification_letter.pdf
http://www.itreetools.org/eco/resources/Milwaukee_Property_Access_Notification_response_card.pdf
https://www.itreetools.org/documents/662/Cheat_Sheet_English_for_distribution_03.01.2021_OFS.pdf
http://www.itreetools.org/eco/resources/Casey_Trees_UFORE_Management_GUIDE.pdf
http://www.itreetools.org/eco/resources/CLC_Outreach_Report.pdf
http://www.itreetools.org/eco/resources/iTreeFieldWork_StandardPlot_Slides.pdf
http://www.itreetools.org/eco/resources/Eco_data_explanations.pdf

Additional resources - videos ﬁ

Eco Basics, Project Creation, and External Import Steps i-Iree
Eco vb highlights and overview - 5 min. - video highlights features and options in the i-Tree Eco v6 application.

Importing external inventory data into Eco v6 - 8 min. - Instructions for setting up an Eco v6 inventory project and importing in external data.

Eco vb sample project creation - 8 min. - Creating a plot-based sample project using the i-Tree Eco v6 application.

Eco vb complete inventory project creation - 11 min. - Creating a complete inventory project using the i-Tree Eco v6 application.

Eco Plot Establishment

Basic Eco sample plot establishment - 2 min. - How to lay out a simple 1/10t acre plot for an Eco sample project.

Eco wooded plot establishment - 3 min. - How to lay out an Eco sample plot partially in a wooded area.

Measuring plot reference object - 2 min. - How to measure a reference or permanent object from an established eco plot center.

Eco Tree Measurements

I-Tree Eco - Basic tree height measurements - S min. - How to measure total tree height, height to live top, and height to crown base
Simple tree DBH measurement - 2 min. - How to measure a single stem tree (DBH) diameter at breast height.

CLE - Crown Light Exposure - 3 min. - How to determine the crown light exposure (CLE) for a tree during Eco field data collection

Using the i-Tree Eco v6 Mobile Data Collection (MDC) system

Mobile Data Collection part 1 - How To Submit A Project To A Mobile Device - 5 min. - In this video there are instructions concerning how to submit i-Tree Eco
inventory and plot-based projects to the mobile data collector.

Mobile Data Collection part 2 - How To Collect Data With The Mobile Data Collector - 8 min. - In this video there are instructions concerning how to collect
data with the mobile data collector for i-Tree Eco inventory and plot-based projects.

Mobile Data Collection part 3 - Retrieving Data - 3 min. - In this video there are instructions concerning how to retrieve data that has been collected using the
mobile data collector for i-Tree Eco inventory and plot-based projects.

Mobile Data Collection Project Management Tips - 3 min. - This video is supplemental to the three-part series concerning the mobile data collector. In this
video there are examples of, and solutions to, the sticking points we are aware of users encountering while using the mobile data collector.

Mobile Data Collection: Recording coordinates for plot center or tree locations- 3 min. - This video demonstrates using the Eco v6 Mobile Data Collection
(MDC) system options for recording plot center or tree locations.



http://www.itreetools.org/media/watch.php?4QMyhlnG8gk?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?m3riZhE_uSg?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?XEcdgVRTYd4?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?5NhQPv0t_Pw?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?iKGBvbQ95jc?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?k-obQsYFRJ4?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?4erHU2ZqduI?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?xUTbU2KveZs?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?s5IgZyxxkWQ?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
https://vimeo.com/406360770
http://www.itreetools.org/media/watch.php?bb77BcdpeO8?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?cR1hKVPWUWw?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?ymp1Uiqg6WQ?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
http://www.itreetools.org/media/watch.php?U4Vq_JCWGbo?list=PLTpJ4X0F9py0KchjAnoXCvihW-SL4QHry
https://youtu.be/54aYhptRzEc
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